
Y11275-201-0110

Matrox Mojito 4K
Installation and User Guide

January 24, 2014



Copyright © 2014 Matrox Electronic Systems Ltd. All rights reserved. 
Disclaimer Matrox Electronic Systems Ltd. reserves the right to make changes in specifications at any time and without notice. 
The information provided by this document is believed to be accurate and reliable. However, no responsibility is assumed by Matrox 
Electronic Systems Ltd. for its use; nor for any infringements of patents or other rights of third parties resulting from its use. No 
license is granted under any patents or patent rights of Matrox Electronic Systems Ltd.

Unauthorized recording or use of broadcast television programming, video tape, or other copyrighted material may violate copyright 
laws. Matrox Electronic Systems Ltd. assumes no responsibility for the illegal duplication, use, or other acts that infringe on the 
rights of copyright owners.

Matrox Electronic Systems Ltd.
1055 St. Regis Blvd., Dorval, Quebec, Canada  H9P 2T4
Tel: (514) 685-2630 Fax: (514) 685-2853 World Wide Web: www.matrox.com

Trademarks
Matrox Electronic Systems Ltd. ...........................................................................Matrox®, Matrox Mojito™, Mtx.utils™
Adobe Systems Inc..............................................................................................Adobe®, After Effects®, Encore®, Photoshop®, 

Prelude®, Premiere® , SpeedGrade®

Intel Corporation .................................................................................................Intel®, Xeon®

Microsoft Corporation..........................................................................................Microsoft®, Windows®

NVIDIA Corporation..............................................................................................NVIDIA®, GeForce®

PCI-SIG ...............................................................................................................PCI-SIG®, PCIe® 

All other nationally and internationally recognized trademarks and tradenames are hereby acknowledged.

www.matrox.com


i

Matrox Limited Warranty

Limited Warranty Statement
1 Matrox* (“Matrox”) having its head office at 1055 St-Regis Blvd., Dorval, Quebec Canada tel: (514) 822-6000 

warrants that the Matrox hardware products (the “Matrox Product”) will be free from defects in materials and 
workmanship under normal use for a period of three (3) years from the date of purchase by the original customer 
(“Customer” or “You”) who provides adequate proof of purchase and payment (for example, a copy of your sales 
receipt or purchase invoice). The warranties provided by Matrox in this Matrox limited warranty statement apply 
only to Matrox Products that the Customer purchases for use, and not for resale. This warranty applies only to the 
original Customer and is non-transferable. MATROX DOES NOT WARRANT THAT THE OPERATION OF THE 
MATROX PRODUCT WILL BE UNINTERRUPTED OR ERROR-FREE, THAT DEFECTS IN THE MATROX 
PRODUCT WILL BE CORRECTED, OR THAT THE MATROX PRODUCT WILL MEET THE CUSTOMER'S 
REQUIREMENTS OR PERFORM WITH ANY HARDWARE OR SOFTWARE PROVIDED BY THIRD 
PARTIES. Conditions and limitations of Matrox's warranty are stated below.

2 Matrox's limited warranty applies only to the Matrox Product entirely manufactured by or for Matrox. The limited 
warranty does not apply to any non-Matrox hardware products or any software, even if packaged or sold with the 
Matrox Product. Manufacturers, suppliers or publishers other than Matrox may provide their own warranties to the 
Customer, but Matrox, insofar as permitted by law, provides their products “as is.” Software provided by Matrox 
is not covered under this limited warranty (please refer to the licensing agreement accompanying the software for 
details of the terms applicable to such).

3 Matrox's limited warranty covers only those defects which arise as a result of normal use of the Matrox Product 
and does not apply to any damage which arises from:

a improper or inadequate maintenance;

b incompatibilities due to the Customer's hardware or software applications, including non-Matrox products, 
with or in which the Matrox Product interfaces;

c Matrox Product of a special or custom-made nature;

d unauthorized modification or misuse, including physical damage to the Matrox Product caused by the 
Customer or due to transportation of the product;

e improper installation, abuse, misapplication or negligence;

f failure to follow instructions relating to Matrox Product's use;

g operation outside the Matrox Product's environmental specifications;

h improper site preparation or maintenance;

i software;

j service performed by anyone who is not a representative of Matrox;

k other causes that do not relate to a Matrox Product defect;

l defects or damage suffered as a result of force majeure (including theft);

m defects or damage suffered as a result of normal wear and tear or otherwise due to the normal aging of the 
Matrox Product, and/or

n stolen goods.

The warranty is voided by removal or alteration of identification labels on the Matrox Product or its parts.

4 In the event of a defect in a Matrox Product during the applicable warranty period, Matrox shall at its sole option, 
either i) repair the defect using new or refurbished parts and return the repaired Matrox Product within a 
reasonable delay; or ii) replace the Matrox Product with a Matrox Product that is new or which has been 
manufactured from new or serviceable used parts and is at least functionally equivalent to the original Matrox 
Product and send such replacement Matrox Product within a reasonable delay.

* Matrox is Matrox Electronic Systems Ltd, Matrox Graphics Inc. or Matrox Europe Limited. Head office at 
1055 St-Regis Blvd. Dorval, Quebec, Canada H9P 2T4 Telephone (514) 822-6000.
Matrox Limited Warranty
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5 A replacement Matrox Product or part assumes the remaining warranty of the original Matrox Product. 
When a Matrox Product or part is replaced, any replacement item becomes the Customer's property and the 
replaced item becomes Matrox's property.

6 This warranty is valid in any country where Matrox Products are distributed by Matrox and/or its authorized 
resellers, dealers or distributors.

7 This limited warranty gives the Customer specific legal rights. The Customer may also have other 
rights which vary from state to state in the United States, from province to province in Canada, and 
from country to country elsewhere in the world. 

8 For Australian Consumers: The rights described in this warranty are in addition to the statutory rights to 
which You may be entitled under the Competition and Consumer Act 2010 and other applicable Australian 
consumer protection laws and regulations. Our Matrox Products come with guarantees that cannot be 
excluded under the Australian Consumer Law. You are entitled to a replacement or refund for a major failure 
and compensation for any other reasonably foreseeable loss or damage. You are entitled to have the goods 
repaired or replaced if the goods fail to be of acceptable quality and the failure does not amount to a major 
failure. Goods presented for repair may be replaced by refurbished goods of the same type rather than being 
repaired. Refurbished parts may be used to repair the goods.

Limitations of Warranty
1 TO THE EXTENT PERMITTED BY LAW, THIS WARRANTY AND THE REMEDIES SET FORTH 

ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, REMEDIES AND 
CONDITIONS. NEITHER MATROX NOR ANY OF ITS THIRD PARTY SUPPLIERS MAKES ANY 
OTHER WARRANTY OF ANY KIND, WHETHER EXPRESSED OR IMPLIED, WITH RESPECT TO 
MATROX PRODUCTS. MATROX SPECIFICALLY DISCLAIMS (AND THE CUSTOMER, BY 
ACCEPTING THE MATROX PRODUCT, SPECIFICALLY ACCEPTS SUCH DISCLAIMER AND 
WAIVES) ALL OTHER WARRANTIES, EITHER EXPRESSED OR IMPLIED, ORAL OR WRITTEN, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR OR INTENDED PURPOSE OR USE AND THE WARRANTY AGAINST 
LATENT DEFECTS, WITH RESPECT TO THE HARDWARE AND/OR SOFTWARE. MATROX 
FURTHER DISCLAIMS ANY WARRANTY THAT MATROX PRODUCTS, IN WHOLE OR IN PART, 
WILL BE FREE FROM INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL PROPERTY, 
INCLUDING, WITHOUT LIMITATION, ANY PATENTS, OR PROPRIETARY RIGHTS.

2 To the extent that this limited warranty is inconsistent with the law of the locality where the Customer 
purchases the Matrox Product, this limited warranty shall be deemed modified to be consistent with such 
local law. Under such local law, certain limitations of this limited warranty may not apply to the consumer. If 
Matrox cannot lawfully disclaim statutory or implied warranties, then to the extent permitted by law, all such 
warranties shall be limited in duration to the duration of this express warranty and to repair or replacement 
service as determined by Matrox at its sole discretion.

3 Matrox disclaims any representation that it will be able to repair any Matrox Product under this warranty or 
make a Matrox Product exchange without risk to or loss of the programs or data.

4 To the extent allowed by local law, the remedies provided in this limited warranty are the Customer's sole 
and exclusive remedies. 

Limitations of Liability
1 EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN THE LIMITED WARRANTY, IN 

NO EVENT SHALL MATROX BE LIABLE FOR:

a any direct, indirect, special, incidental, consequential, foreseeable or unforeseeable, or punitive 
damages, whether based on contract, tort, delict or any other legal theory and whether advised of the 
possibility of such damages; and/or
ox Limited Warranty 
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b damages arising from the loss of use, data, Matrox Production revenue, use of money, anticipated savings, 
procurement of substitute goods, business, opportunity, goodwill, reputation and/or profit in connection with 
the Matrox Product or any business interruption.

c Matrox disclaims and shall have no obligation to indemnify or defend You or any third party in respect of any 
actual or alleged infringement of any actual or pending patents, copyright or other intellectual property rights. 
Matrox shall have no liability arising out of any such actual or alleged intellectual property infringement.

2 Without prejudice to the foregoing, any liability of Matrox for any breach of warranty shall be limited to the actual 
amount paid by the Customer for the defective hardware in question.

3 To the extent allowed by local law, Matrox's entire liability and the Customer's exclusive remedy shall be the 
repair or replacement of any defective Matrox Product during the warranty period. Matrox does not offer any other 
warranty with respect to Matrox hardware or software or any other hardware or software.

4 Customer shall be responsible for all applicable taxes, duties and customs fees on any replacement unit, as well as 
all transport, insurance, storage and other charges incurred on all returned Matrox Products.

5 Matrox reserves the right to change its warranties at any time and without notice, at its sole discretion, with 
respect to future sales and deliveries.

6 UNAUTHORIZED USE. THE MATROX PRODUCT AND ANY DOCUMENTATION RELATED THERETO 
ARE NOT DESIGNED, INTENDED, AUTHORIZED OR WARRANTED TO BE SUITABLE FOR USE OR 
RESALE IN ANY TYPE OF SYSTEM OR OTHER APPLICATIONS RELATED TO, HAZARDOUS OR 
POTENTIALLY HAZARDOUS ENVIRONMENTS OR APPLICATIONS REQUIRING 
HIGH-AVAILABILITY OR FAIL-SAFE PERFORMANCE, WHERE PERSONAL INJURY OR DEATH MAY 
OCCUR, SUCH AS MEDICAL SYSTEMS, LIFE SUSTAINING, LIFE SAVING SYSTEMS, OPERATION OF 
NUCLEAR FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC 
CONTROL, PUBLIC WORKS, WEAPONS SYSTEMS, OR ANY OTHER APPLICATION IN WHICH THE 
FAILURE OF A MATROX PRODUCT COULD LEAD TO PROPERTY DAMAGE, ENVIRONMENTAL 
DAMAGE, OR PERSONAL INJURY. CUSTOMER WILL NOT USE, OR PERMIT TO BE USED, THE 
MATROX PRODUCTS FOR SUCH HIGH-AVAILABILITY, FAIL-SAFE OR CRITICAL APPLICATIONS 
AND FURTHER AGREES TO INDEMNIFY, DEFEND AND HOLD HARMLESS MATROX AND ITS 
MANAGERS, DIRECTORS, OFFICERS, EMPLOYEES, AGENTS, AFFILIATES, SUCCESSORS, AND 
ASSIGNS FROM AND AGAINST ANY ACTION, SUIT, PROCEEDING, COST, EXPENSE, DAMAGES, 
AND LIABILITY (INCLUDING, BUT NOT LIMITED TO, REASONABLE ATTORNEYS' FEES) ARISING 
OUT OF, OR RELATED TO, THE BREACH OF CUSTOMER'S OBLIGATIONS RELATED HERETO, EVEN 
IF SUCH CLAIM ALLEGES THAT MATROX WAS NEGLIGENT REGARDING THE DESIGN OR 
MANUFACTURE OF THE MATROX PRODUCT.

Obtaining Service (whether in or out of warranty)
1 Verify that your Matrox Product was installed and configured according to the information in its accompanying 

documentation or at the web site referenced therein.

2 Read the “Troubleshooting” information included with the Matrox Product or at the web site referenced therein, to 
verify if the problem can be easily solved.

3 If You are still experiencing difficulties, please contact your dealer or distributor where You purchased your 
Matrox Product. Please go to http://www.matrox.com/hr/en/company/legal/en/warranty, to find the list of Matrox 
authorized dealers and/or distributors in your area.

4 Alternatively, if this first option is unavailable to You and you are still experiencing problems or if you believe that 
your product is defective, please contact the Matrox Support team. We will help you troubleshoot your issue and 
process a replacement if it is found to be defective. Matrox support team can be reached at 
http://www.matrox.com/hr/en/company/legal/en/warranty.

5 Before returning the Matrox Product, please back up any and all information or data thereon, including, without 
limitation, confidential, proprietary, personal or other information. All data and information on the Matrox 
Product will be lost given that the persistent storage device(s) will be reformatted to factory default during testing; 
Matrox Limited Warranty
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and Matrox cannot, and does not, accept any responsibility for any information that may be lost, corrupted, 
damaged or otherwise rendered inaccessible.

6 When returning a Matrox Product, leave the configuration as it was when You were using it, and leave all 
identification stickers on the Matrox Product. Pack the Matrox Product in its original box and return it to 
your Matrox dealer or distributor where the Matrox Product was purchased, together with your proof of 
purchase. Your Matrox dealer or distributor will return the Matrox Product for You. Alternatively, You may 
proceed by returning your Matrox Product by following the guidelines referred to at the following address 
http://www.matrox.com/hr/en/company/legal/en/warranty, and follow the link to Customer Support, where a 
Return Merchandise Authorization (RMA) number will be issued, upon receipt of adequate proof of 
purchase, and shipping instructions will be given to you. Customer will be responsible in paying the freight 
to send the Matrox Product for service. Please ensure that the product is in Electrostatic discharge (ESD) 
packaging before shipping it back to Matrox or else the warranty shall be void.

DO NOT RETURN THE MATROX PRODUCT TO MATROX WITHOUT MATROX'S RMA NUMBER 
AND EXPRESS AUTHORIZATION.

Once an RMA number is issued, the Matrox Product must be returned to Matrox within thirty (30) days.

NON-WARRANTY product will be shipped back to You collect or on your courier account number, if one is 
provided.

General
1 This limited warranty shall be governed by the laws of the Province of Quebec, Canada and the federal laws 

of Canada applicable therein and the courts of the Province of Quebec shall have exclusive jurisdiction to hear 
and decide any dispute instituted by the Customer in connection with this limited warranty; the Customer 
waives, by accepting the Matrox Product, its rights to institute proceedings in connection with this warranty 
against Matrox in any jurisdiction other than Quebec. Customer hereby agrees to all terms of this warranty in 
the English language. The United Nations Convention on Contracts for the International Sale of Goods does 
not apply to this warranty and is strictly excluded.

2 Except as may be expressly agreed to the contrary in a signed written agreement between Customer and 
Matrox, i) any written or oral information or advice given by Matrox's distributors, agents or employees will 
in no way increase the scope of the limited warranty contained in this limited warranty; and ii) this limited 
warranty states the only warranty made to You by Matrox with respect to the units of Matrox Product that 
You have purchased, and the terms of this limited warranty shall override the terms of any purchase orders 
and any other terms and understandings You may seek to apply in respect thereof.

3 This limited warranty is personal to You and cannot be assigned or transferred without Matrox's prior written 
agreement.

4 The failure by Matrox to enforce any of the provisions of this limited warranty shall not constitute a waiver 
of Matrox's rights to enforce such provision or any other provision of this limited warranty in the future.

5 If any clause in this limited warranty is held by a court of law to be illegal or unenforceable the remaining 
provisions of this limited warranty shall not be affected thereby.
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Matrox Software License Agreement

THIS IS A LEGAL AGREEMENT BETWEEN THE LICENSEE AND MATROX ELECTRONIC SYSTEMS LTD. 
(“MATROX”) CONCERNING THE USAGE OF THE MATROX SOFTWARE. BY DOWNLOADING, 
INSTALLING, COPYING, ACCESSING, CLICKING ON AN “ACCEPT” BUTTON, OR OTHERWISE USING 
THE SOFTWARE, THE LICENSEE AGREES TO THE TERMS OF THIS AGREEMENT. IF YOU ARE 
ACCEPTING THESE TERMS ON BEHALF OF YOUR COMPANY, ORGANIZATION, EDUCATIONAL 
INSTITUTION, OR AGENCY, INSTRUMENTALITY, OR DEPARTMENT OF THE FEDERAL GOVERNMENT 
AS ITS AUTHORIZED LEGAL REPRESENTATIVE, YOU REPRESENT AND WARRANT THAT YOU HAVE 
FULL AUTHORITY TO BIND LICENSEE TO THESE TERMS. IF YOU DO NOT AGREE TO THE TERMS OF 
THIS AGREEMENT, PLEASE RETURN YOUR MATROX PRODUCT. IF THE SOFTWARE WAS 
DOWNLOADED, DESTROY ALL COPIES OF THE SOFTWARE.

In this agreement “Software” refers to: any firmware, software, associated software components, media, printed 
materials, and “online” or electronic documentation related to Matrox products.

The Software is not sold, and instead is only licensed for use, strictly in accordance with this document. This license 
does not cover the sale of hardware, since it may not necessarily be sold as a package with the Software.  This license 
sets forth the terms and conditions of the Software license only.

Any Software provided to Licensee is the copyrighted work of Matrox and/or its suppliers. The present License does 
not give Licensee any intellectual property rights to the Software or its derivatives. The downloading and/or the use of 
any Software are subject to the following restrictions and limitations:

LICENSES:
If you are an end user, the “End User License” shall apply to you.

If you are an original equipment manufacturer (OEM), the “OEM License” shall apply to you. 

END USER LICENSE
1 Licensee may install the Software on an unlimited number of computers owned or leased by Licensee in any 

location. However, Licensee must use the Software on a single computer owned or leased by Licensee at a time, in 
conjunction with and for the purpose of, operating the Matrox  hardware. Licensee shall also have the right to make 
one copy of the Software in any computer-readable or printed form for back-up or archival purposes;

2 No right to recopy, sell, distribute, license, sub-license, alter, modify, disassemble, de-compile or reverse engineer 
any Software in any manner whatsoever is hereby given, except as provided in this Agreement.  Violation may 
result in severe civil and/or criminal penalties, as violators will be prosecuted to the maximum extent possible;

3 Licensee agrees to treat the Software as confidential information, and shall protect said information by using the 
same degree of care Licensee uses to protect Licensee's own confidential information, but no less than a 
reasonable degree of care, to prevent the unauthorized use, dissemination, disclosure or publication of such;

4 Licensee may only provide and disclose parts of the Software to third parties who have a need-to-know for the 
purpose of installation, service integration and/or support of said Software within Licensee's product. In such 
event, Licensee may only disclose the relevant and necessary parts of the Software to permit the third party to 
accomplish his work provided that all such disclosures shall be subject to the terms and conditions of this 
Agreement;

5 Licensee may not grant any sublicense, lease or other right in the Software to others;

6 Notwithstanding any other provision in this License, if Licensee provides any ideas, suggestions or 
recommendations to Matrox regarding the Licensed Software and/or Licensee's product (“Feedback”), Matrox is 
free to use and incorporate such Feedback in Matrox's products, without payment of royalties or other 
consideration to Licensee.
Matrox Software License Agreement



vi

Matr
OEM LICENSE
Licensee may reproduce and distribute the Software only as an integral part of or incorporated in Licensee's 
product or as a standalone Software maintenance update for existing end users of Licensee's products, excluding 
any other standalone products, subject to these conditions:

1 This Software is licensed for use only in conjunction with Matrox products. Use of the Software in 
conjunction with non-Matrox products is not licensed hereunder;

2 No right to recopy, sell, distribute, license, sub-license, alter, modify, disassemble, de-compile or reverse 
engineer any Software in any manner whatsoever is hereby given, except as provided in this Agreement.  
Violation may result in severe civil and/or criminal penalties, as violators will be prosecuted to the maximum 
extent possible;

3 Licensee agrees to treat the Software as confidential information, and shall protect said information by using 
the same degree of care Licensee uses to protect Licensee's own confidential information, but no less than a 
reasonable degree of care, to prevent the unauthorized use, dissemination, disclosure or publication of such;

4 You may only distribute the Software to your customers pursuant to a written license agreement. At a 
minimum such license shall safeguard Matrox's ownership rights to the Software;

5 Licensee may only provide and disclose parts of the Software to third parties who have a need-to-know for 
the purpose of installation, service integration and/or support of said Software within Licensee's product. In 
such event, Licensee may only disclose the relevant and necessary parts of the Software to permit the third 
party to accomplish his work provided that all such disclosures shall be subject to the terms and conditions 
of this Agreement;

6 Notwithstanding any other provision in this License, if Licensee provides any ideas, suggestions or 
recommendations to Matrox regarding the Licensed Software and/or Licensee's product (“Feedback”), 
Matrox is free to use and incorporate such Feedback in Matrox's products, without payment of royalties or 
other consideration to Licensee.

GENERAL LICENSE TERMS: (APPLICABLE TO BOTH END-USERS & OEM'S)
There are inherent dangers in the use of any software available for downloading on the Internet and Matrox 
cautions Licensee to ensure that Licensee completely understands the potential risks before downloading any of 
the Software. Licensee is solely responsible for adequate protection and backup of the data and equipment used 
in connection with any of the Software, and Matrox will not be liable for any damages that may be suffered in 
connection with use of the Software.

Licensee hereby acknowledges and agrees that this License, and all its terms and conditions, automatically 
applies, without other notice, to future updates of the Software, firmware, BIOS, drivers and associated utilities.

COPYRIGHT
All title, including but not limited to copyrights, in and to the Software and any copies thereof are owned by 
Matrox or its suppliers. All title and intellectual property rights in and to the content which may be accessed 
through use of the Software is the property of the respective content owner and may be protected by applicable 
copyright or other intellectual property laws and treaties. This Software License Agreement grants you no rights 
to use such content. All rights not expressly granted are reserved by Matrox 

DISCLAIMER OF WARRANTIES
Licensee expressly acknowledges and agrees that use of the Software is at Licensee's sole risk. The Software and 
Documentation is provided “AS IS” AND WITHOUT WARRANTY OF ANY KIND AND MATROX 
EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NON-INFRINGEMENT. MATROX DOES NOT WARRANT THAT THE CONTENTS OF 
THE SOFTWARE OR DOCUMENTATION WILL MEET LICENSEE'S REQUIREMENTS, OR THAT THE 
OPERATION OF THE SOFTWARE OR DOCUMENTATION WILL BE UNINTERRUPTED OR 
ERROR-FREE. THE ENTIRE RISK ASSOCIATED WITH THE USE OF THE SOFTWARE AND 
ox Software License Agreement 
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DOCUMENTATION IS ASSUMED BY LICENSEE. FURTHERMORE, MATROX DOES NOT WARRANT OR 
MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE 
SOFTWARE OR DOCUMENTATION IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, 
CURRENTNESS, OR OTHERWISE. SHOULD THE CONTENTS OF THE SOFTWARE OR DOCUMENTATION 
PROVE DEFECTIVE, LICENSEE ASSUMES THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR 
OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO LICENSEE.

LICENSEE ACKNOWLEDGES AND AGREES THAT LICENSEE IS SOLELY RESPONSIBLE FOR 
DETERMINING WHETHER ANY THIRD PARTY PATENT OR COPYRIGHT LICENSES, INCLUDING BUT 
NOT LIMITED TO VARIOUS AUDIO AND VISUAL STANDARDS, ARE NECESSARY TO USE, IMPLEMENT 
OR DISTRIBUTE THIS PRODUCT, WHICH INCLUDES ANY OR ALL SOFTWARE OR HARDWARE.  
LICENSEE IS RESPONSIBLE TO ADVISE LICENSEE'S CUSTOMERS OF THE LIMITATIONS PROVIDED 
HEREIN.

LIMITATION OF LIABILITY
UNDER NO CIRCUMSTANCES SHALL MATROX, ITS SISTER COMPANIES AND ITS SUBSIDIARIES BE 
LIABLE FOR ANY DIRECT, INDIRECT, PUNITIVE, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL 
DAMAGES THAT RESULT FROM THE USE OF, OR INABILITY TO USE, THE SOFTWARE. THIS 
LIMITATION APPLIES WHETHER THE ALLEGED LIABILITY IS BASED ON CONTRACT, TORT, 
NEGLIGENCE, STRICT LIABILITY, OR ANY OTHER BASIS, EVEN IF MATROX HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE. BECAUSE SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, MATROX'S LIABILITY 
IN SUCH JURISDICTIONS SHALL BE LIMITED TO THE MINIMUM REQUIRED BY LAW.

UNAUTHORIZED USE.  THIS SOFTWARE AND ANY DOCUMENTATION RELATED THERETO ARE NOT 
DESIGNED, INTENDED, AUTHORIZED OR WARRANTED TO BE SUITABLE FOR USE OR RESALE IN ANY 
TYPE OF SYSTEM OR OTHER APPLICATIONS RELATED TO, HAZARDOUS OR POTENTIALLY 
HAZARDOUS ENVIRONMENTS OR APPLICATIONS REQUIRING HIGH-AVAILABILITY OR FAIL-SAFE 
PERFORMANCE, WHERE PERSONAL INJURY OR DEATH MAY OCCUR, SUCH AS MEDICAL SYSTEMS, 
LIFE SUSTAINING, LIFE SAVING SYSTEMS, OPERATION OF NUCLEAR FACILITIES, AIRCRAFT 
NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, PUBLIC WORKS, WEAPONS 
SYSTEMS, OR ANY OTHER APPLICATION IN WHICH THE FAILURE OF A PRODUCT COULD LEAD TO 
PROPERTY  DAMAGE, ENVIRONMENTAL DAMAGE, OR PERSONAL INJURY.  LICENSEE WILL NOT USE, 
OR PERMIT TO BE USED, THE PRODUCTS FOR SUCH HIGH-AVAILABILITY, FAIL-SAFE OR CRITICAL 
APPLICATIONS AND FURTHER, LICENSEE AGREES TO INDEMNIFY, DEFEND AND HOLD HARMLESS 
MATROX AND ITS MANAGERS, DIRECTORS, OFFICERS, EMPLOYEES, AGENTS, AFFILIATES, 
SUCCESSORS, AND ASSIGNS FROM AND AGAINST ANY ACTION, SUIT , PROCEEDING, COST, 
EXPENSE, DAMAGES, AND LIABILITY (INCLUDING, BUT NOT LIMITED TO, REASONABLE 
ATTORNEYS' FEES) ARISING OUT OF , OR RELATED TO, THE BREACH OF LICENSEE'S OBLIGATIONS 
RELATED HERETO, EVEN IF SUCH CLAIM ALLEGES THAT MATROX WAS NEGLIGENT REGARDING 
THE DESIGN OR MANUFACTURE OF THE SOFTWARE.

TERMINATION
This License will automatically terminate if Licensee fails to comply with any of the terms and conditions hereof. In 
such event, Licensee must destroy all copies of the Software and all of its component parts.  Matrox reserves the right 
to terminate this License without prejudice to any additional recourses Matrox may have against Licensee if Licensee 
violates any of this Licenses' terms and conditions.

Matrox will not, by reason of the termination of this Agreement, be liable for compensation, reimbursement or 
damages on account of the loss of prospective profits on anticipated sales, or on account of expenditures, investments, 
leases, or commitments in connection with the Licensee's business or goodwill or otherwise.
Matrox Software License Agreement
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If Licensee commences or participates in any legal proceeding against Matrox then Matrox may, in its sole 
discretion, suspend or terminate all license grants and any other rights provided under this License during the 
pendency of such legal proceedings.

MISCELLANEOUS
If any provision of this License is inconsistent with, or cannot be fully enforced under, the law, such provision 
will be construed as limited to the extent necessary to be consistent with and fully enforceable under the law. 
This License is the final, complete and exclusive agreement between the parties relating to the subject matter 
hereof, and supersedes all prior or contemporaneous understandings and agreements relating to such subject 
matter, whether oral or written. This License may only be modified in writing signed by an authorized officer of 
Matrox. Licensee agrees that it will not ship, transfer or export the Software into any country, or use the Software 
in any manner, prohibited by the United States Bureau of Industry and Security or any export laws, restrictions or 
regulations.

Controlling Law.  The validity, performance and construction hereof shall be governed by and interpreted in 
accordance with the laws of the Province of Quebec.  Both parties hereby irrevocably submit to the exclusive 
jurisdiction of the Courts of the district of Montreal, Province of Quebec, Canada with regard to any dispute 
arising out of or in connection with this Agreement.

Additional information may be available on the Matrox website. If used, this site may contain other proprietary 
notices and copyright information, the terms of which must also be observed and followed.

The failure of Matrox to enforce at any time any of the provisions of this Agreement, or the failure to require at 
any time performance by the Licensee of any of the provisions of this Agreement, shall in no way be construed to 
be a present or future waiver of such provisions, nor in any way affect the right of Matrox to enforce each and 
every such provision thereafter.

All rights reserved by Matrox.

Matrox reserves the right to change Software specification without notice. All intellectual property, including 
without limitation, trademarks and copyrights are the property of their respective owners and any unauthorized 
use thereof is strictly prohibited.

COPYRIGHT © 2012 Matrox is a trademark of Matrox Electronic Systems Ltd.
ox Software License Agreement 
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Matrox End-User VFW Software Codec License Agreement (“Agreement”)

IMPORTANT - PLEASE READ THIS LICENSE AGREEMENT CAREFULLY BEFORE INSTALLING, 
COPYING OR USING THE SOFTWARE. THIS IS A LEGAL AGREEMENT BETWEEN YOU THE END USER 
(“END USER”) AND MATROX ELECTRONIC SYSTEMS LTD. (“MATROX”) CONCERNING THE MATROX 
VIDEO FOR WINDOWS SOFTWARE CODEC PACKAGE (COLLECTIVELY, THE “SOFTWARE”) WHICH END 
USER WISHES TO USE FOR PERSONAL USE. END USER ACKNOWLEDGES AND AGREES THAT IT WILL 
BE LEGALLY BOUND BY THE TERMS OF THIS AGREEMENT.

Supported formats: DV/DVCAM, DVCPRO, DVCPRO50, DVCPRO HD, MPEG-2 I-frame SD, MPEG-2 I-frame 
HD (includes 720p, full-size 1080i/p, and 1440x1080i/p), MPEG-2 I-frame SD + Alpha, MPEG-2 I-frame HD + 
Alpha, Offline HD, HDV and EZ-HDV (playback only), Uncompressed 8-bit and 10-bit SD, Uncompressed 8-bit and 
10-bit HD, Uncompressed 8-bit and 10-bit SD + Alpha, Uncompressed 8-bit and 10-bit HD + Alpha, EZ-MXF 
(playback only), and Motion-JPEG (playback only).

1. LICENSE
Matrox hereby grants the End User a non-exclusive, non-transferable, royalty-free, right to use and copy in object code 
form the Software for internal purposes in conjunction with a Matrox product only (the “Purpose”), subject to the 
terms and conditions of this Agreement. End user shall only use the Software on a single computer at a time. End User 
must maintain all copyright notices on all copies of the Software. Matrox may make changes to the Software at any 
time without prior notice. In addition, Matrox is under no obligation whatsoever to update, maintain, or provide new 
versions of the Software or to provide any support in connection with the Software.

2. RESTRICTIONS
End User agrees that it will not: (a) sell, rent, assign or transfer or grant a sublicense of the Software or the license 
contained herein to any other party; (b) adapt, alter, modify, prepare derivative works from, merge or transfer the 
Software; (c) break or attempt to break the protection algorithm, reverse engineer, reverse assemble, reverse compile or 
otherwise translate the Software or any portion thereof, even if permitted under any provision of any applicable laws; 
(d) use Matrox's name, logo or trademark to market its own products; (e) use, reproduce alter and redistribute the 
Software in whole or in part other than for the Purpose.

End User may not use the Software for any unlawful purpose, including infringement of the copyrights or other 
propriety rights of others, or in any illegal manner or for creation or distribution of unlawful content. End User agrees 
to indemnify Matrox for any and all claims arising from any violation by it of the terms of this License Agreement.

End User acknowledges that the Software is subject to export laws and agrees to comply with all applicable 
international and national laws that apply to these products.

3. COPYRIGHT AND OWNERSHIP
End User acknowledges and agrees that the Software and all associated documentation, including logos, names and 
other support materials furnished in this package are exclusively owned by Matrox and/or its suppliers. The Software 
codes, structure and organization are the valuable trade secrets of Matrox. The Software and all associated 
documentation are also protected by copyright laws and international copyright treaties, as well as other intellectual 
property laws and treaties. No title to the intellectual property in the Software, the documentation, 
magnetic/optical/solid-state media or any other material provided therewith is transferred to End User by this 
Agreement. This Agreement does not convey to End User an interest in or to the Software, but only a limited right to 
use the Software in accordance with the terms of this Agreement. The Software is licensed to End User and not sold.

4. EXCLUSION OF WARRANTY
MATROX PROVIDES TO END USER THE SOFTWARE AND RELATED DOCUMENTATION ON AN “AS IS” 
BASIS WITHOUT ANY WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED INCLUDING BUT 
NOT LIMITED TO ANY IMPLIED WARRANTY OF MERCHANTABILITY, NON-INFRINGEMENT OR 
FITNESS FOR A PARTICULAR PURPOSE AS WELL AS THE WARRANTY AGAINST HIDDEN OR LATENT 
DEFECTS, ALL OF WHICH MATROX SPECIFICALLY DISCLAIMS (AND THE CUSTOMER BY ACCEPTING 
THE PRODUCT SPECIFICALLY ACCEPTS SUCH DISCLAIMER AND WAIVER) TO THE MAXIMUM 
Matrox End-User VFW Software Codec License Agreement (“Agreement”)
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EXTENT PERMITTED BY LAW. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF 
THE SOFTWARE IS ASSUMED BY END USER. SHOULD THE SOFTWARE PROVE DEFECTIVE, END 
USER (AND NOT MATROX, ITS DISTRIBUTORS OR DEALERS) ASSUMES THE ENTIRE COST OF 
ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

MATROX DOES NOT WARRANT THAT THE SOFTWARE WILL MEET END USER'S REQUIREMENTS 
OR THAT IT'S OPERATION WILL BE ERROR-FREE.

MATROX HAS NO OBLIGATION TO INDEMNIFY, DEFEND OR HOLD END USER HARMLESS FROM 
AND AGAINST ANY CLAIM THAT ANY THIRD PARTY SOFTWARE INFRINGES ANY THIRD PARTY 
PATENT, COPYRIGHT, TRADEMARK OR OTHER INTELLECTUAL PROPERTY RIGHT. END USER 
WILL PROMPTLY NOTIFY MATROX IN WRITING OF ANY SUCH CLAIM.

MATROX HAS NO OBLIGATION TO INDEMNIFY, DEFEND OR HOLD END USER HARMLESS FROM 
AND AGAINST ANY CLAIMS OF INFRINGEMENT OF INTELLECTUAL PROPERTY THAT READS 
UPON OR IS INFRINGED BY A GENERALLY RECOGNIZED AUDIO, VIDEO, TECHNOLOGY OR 
PATENT STANDARD OR RECOMMENDATIONS, INCLUDING WITHOUT LIMITATION AVC/H.264, 
IEEE 1394, JPEG, JPEG2000, MPEG-1, MPEG-2 AND MPEG-4.

5. LIMITATION OF LIABILITY
A Each party as well as any of its officers, employees, suppliers, agents or subcontractors shall under no 

circumstance whatsoever and whether a claim is based on breach of contract or warranty, infringement or any 
other intellectual property claims, negligence, strict liability in tort or otherwise or arises under any other 
doctrine in law or equity, be liable to or have to indemnify the other party for:

(i) Indirect, special, incidental, punitive and consequential damages, whether foreseeable or unforeseeable, 
and even if advised of the possibility of such damages or losses;

(ii) Damages arising from loss of use, data, profits, production revenue, bargain, business, revenues, 
anticipated savings, opportunities, investment or loss or production, wasted expenditures, costs of 
substitute goods or services and generally any kind of economic, commercial and financial loss arising 
directly or indirectly out of or in connection with this Agreement, including without limitation all such 
damages and losses resulting from the use of the Software, any mistakes, errors, delays, defects, 
failures, defaults, interruptions or generally any acts or omissions, whether or not the party has been 
advised of the possibility of such damages or losses. The total and cumulative liability from one party to 
the other party arising from or in connection with this Agreement (whether liabilities arise from breach 
of contract or warranty, negligence, strict liability in tort or otherwise or under any other doctrine in law 
or equity) shall under no circumstance exceed the aggregate of all fees and payments actually received 
by Matrox from End User under this Agreement.

B Matrox will have no obligations under this section or otherwise with respect to any infringement claim in 
whole or in part based upon any direct, contributory or other infringement related to the licensed Software, 
or the use thereof, with respect to (including conformance to) any standards promulgated, revised or 
maintained by a standards organization, standards bodies or similar private or public organization, including, 
without limitation,  the various standards promulgated by the MPEG Licensing Authority, LLC (or MPEG 
LA). Matrox has no obligation to indemnify, defend or hold End User harmless from and against any claims 
of infringement of intellectual property that reads upon or is infringed by a generally recognized audio, 
video, technology or patent standard or recommendations, including without limitation AVC/H.264, IEEE 
1394, JPEG, JPEG2000, MPEG-1, MPEG-2 and MPEG-4.

6. CONFIDENTIALTY
Except as licensed hereunder, End User shall treat the Software and all related information as confidential 
information and refrain from making any such information or the Software itself available to any other person. 
End User will take commercially reasonable precautions to safeguard the confidentiality of the Software, 
including those taken by End User to protect its own trade secrets. The obligation of confidentiality shall not 
apply or shall cease to apply to any information that (a) was known to End User independently of its receipt 
hereunder; (b) is or becomes publicly available without breach of this Agreement; or (c) is disclosed by End User 
ox End-User VFW Software Codec License Agreement (“Agreement”) 
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pursuant to court order or other requirement imposed by law, provided that Matrox is given a reasonable opportunity to 
object to or restrict such disclosure requirement to the extent practicable, and then such disclosure shall be permitted 
only subject to the terms and conditions of such order or other legal requirement.

7. TERMINATION
This Agreement is effective until terminated. End User may terminate this Agreement at any time by destroying all 
copies of the Software and related materials. This Agreement is conditioned upon End User's continued compliance 
with the Agreement and will terminate automatically and irrevocably if End User fails to comply with any material 
term or condition of this Agreement. Matrox will provide written notice to End User of such termination in advance 
where practical, or otherwise promptly following such termination.  Such termination is without prejudice to Matrox's 
other rights hereunder at law or in equity. In event of termination, End User must destroy all copies of the Software and 
related materials and certify in writing and under oath that all such copies have been destroyed, and End User's license 
and rights under this Agreement shall terminate. In the event of termination of this Agreement, the provisions of 
Sections 2, 3, 4, 6, 7, 8 and 10 shall survive and will remain in full force and effect.

8. GENERAL

8.1. Matrox shall not be liable for delay or failure in performance resulting from acts beyond its reasonable control, 
including but not limited to acts of God, acts of war, terrorism, riot, fire, flood, or other disaster, acts of government, 
strike, lockout, communication line or power failure.

8.2. End User shall not have the right to assign the benefit of this Agreement without the prior written permission 
from Matrox and then only under such conditions as Matrox may reasonably determine.

8.3. If any provision of this Agreement is declared by a body of competent jurisdiction to be invalid, such provision 
shall be severed from this Agreement and the other provisions shall remain in full force and effect.

8.4. A term or condition of this Agreement can be waived or modified only with the written consent of both parties. 
Forbearance or indulgence by either party in any regard shall not constitute a waiver of the term or condition to be 
performed, and either party may invoke any remedy available under this Agreement or by law despite such forbearance 
or indulgence.

8.5. The relationship between Matrox and you is that of an independent contractor and its customer and under no 
circumstances shall either party, its agents or employees be deemed agents or representatives of the other party.  
Neither party shall have the right to enter into any contracts or commitments in the name of or on behalf of the other 
party in any respect whatsoever.  In addition, neither party shall hold itself out to anyone, or otherwise represent, that it 
has any such authority vis-a-vis the other party.
Both parties agree to comply with all applicable laws, rules, regulations, orders and ordinances of the state, province 
and/or country where it resides and in any other state, province and/or country with jurisdiction over it or its activities 
in performance of its obligations hereunder, including without limitation all applicable duty, taxes, import and/or 
export regulations and all licensing or permit requirements.

8.6. This Agreement and any schedule attached hereto contains the complete and exclusive statement of the 
agreement between the parties and supersedes all prior and contemporaneous agreements, including, but not limited to, 
understandings, proposals, negotiations, representations or warranties of any kind whether oral or written with respect 
to the subject matter hereof. No oral or written representation which is not expressly contained in this Agreement is 
binding on Matrox or End User.

8.7. This Agreement will be governed by and construed in accordance with the laws of the Province of Quebec.  The 
United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement.

9. UNAUTHORIZED USE
THIS SOFTWARE AND ANY DOCUMENTATION RELATED THERETO ARE NOT DESIGNED, INTENDED, 
AUTHORIZED OR WARRANTED TO BE SUITABLE FOR USE OR RESALE IN ANY TYPE OF SYSTEM OR 
Matrox End-User VFW Software Codec License Agreement (“Agreement”)
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OTHER APPLICATIONS RELATED TO, HAZARDOUS OR POTENTIALLY HAZARDOUS 
ENVIRONMENTS OR APPLICATIONS REQUIRING HIGH-AVAILABILITY OR FAIL-SAFE 
PERFORMANCE, WHERE PERSONAL INJURY OR DEATH MAY OCCUR, SUCH AS MEDICAL 
SYSTEMS, LIFE SUSTAINING, LIFE SAVING SYSTEMS, OPERATION OF NUCLEAR FACILITIES, 
AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, PUBLIC 
WORKS, WEAPONS SYSTEMS, OR ANY OTHER APPLICATION IN WHICH THE FAILURE OF A 
PRODUCT COULD LEAD TO PROPERTY  DAMAGE, ENVIRONMENTAL DAMAGE, OR PERSONAL 
INJURY.  LICENSEE WILL NOT USE, OR PERMIT TO BE USED, THE PRODUCTS FOR SUCH 
HIGH-AVAILABILITY, FAIL-SAFE OR CRITICAL APPLICATIONS AND FURTHER, LICENSEE AGREES 
TO INDEMNIFY, DEFEND AND HOLD HARMLESS MATROX AND ITS MANAGERS, DIRECTORS, 
OFFICERS, EMPLOYEES, AGENTS, AFFILIATES, SUCCESSORS, AND ASSIGNS FROM AND 
AGAINST ANY ACTION, SUIT , PROCEEDING, COST, EXPENSE, DAMAGES, AND LIABILITY 
(INCLUDING, BUT NOT LIMITED TO, REASONABLE ATTORNEYS' FEES) ARISING OUT OF , OR 
RELATED TO, THE BREACH OF LICENSEE'S OBLIGATIONS RELATED HERETO, EVEN IF SUCH 
CLAIM ALLEGES THAT MATROX WAS NEGLIGENT REGARDING THE DESIGN OR MANUFACTURE 
OF THE SOFTWARE.

10. CHOICE OF LAW
This Agreement shall be governed by and interpreted in accordance with the laws of the Province of Quebec, 
excluding any conflict of laws provisions. All disputes arising out of this Agreement shall be subject to the 
exclusive jurisdiction of the courts of the Province of Quebec, district of Montreal, and the parties agree and 
submit to the personal and exclusive jurisdiction and venue of these Courts.
ox End-User VFW Software Codec License Agreement (“Agreement”) 
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Introducing Matrox Mojito 4K

This chapter lists the Mojito 4K 
system requirements, and 
describes the Mojito 4K 
documentation.
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Welcome to Matrox Mojito 4K
Matrox Mojito 4K is a quad 3G-SDI card that provides realtime monitoring and 
output of video footage at resolutions ranging from SD up to 4K (4096×2160) at 
59.94 fps. With support for Adobe creative tools such as Premiere Pro, After 
Effects, and Photoshop, you can edit and finish your productions while ensuring 
that what you see is what you are delivering. Matrox Mojito 4K provides the 
highest quality video editing experience by outputting projects with 1:1 pixel 
accuracy and 10-bit color precision to the monitor.

Matrox Mojito 4K supports up to eight or 16 channels of embedded SDI audio 
output so that you can choose from working with a simple stereo mix to surround 
sound and beyond for all your post-production needs.

System requirements
Matrox Mojito 4K requires a computer system with the following configuration:

• HP Z820 workstation with one of the following processors:

$ 3.3 GHz dual quad-core Intel Xeon E5-2643 (for 4K at 29.97 fps 
playback).

$ 2.7 GHz dual 8-core Intel Xeon E5-2680 (for 4K at 59.94 fps playback).

• Microsoft Windows 7 (64-bit) with Service Pack 1.

• 32 GB of RAM.

• One free x8 PCIe slot (x8 electrical).

• An NVIDIA GeForce GTX 780 (3 GB) display card is recommended.

Supported programs
For a complete list of the Adobe applications supported for using Matrox 
Mojito 4K with the current software release, see the “Supported OS and 
Applications” document provided in the “Downloads” section of the Matrox 
Mojito 4K Support website at www.matrox.com/video/support.

Check our website for equipment information
For up-to-date information about system requirements and Matrox-tested 
systems for Matrox Mojito 4K, check the “System Recommendations” section of 
the Matrox Mojito 4K Support website at www.matrox.com/video/support.

About this manual
This manual provides you with information about installing and using your 
Matrox Mojito 4K hardware and software, including how to configure supported 
applications for use with Matrox Mojito 4K.
pter 1, Introducing Matrox Mojito 4K
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Style conventions
The following style conventions are used in this manual:

• The names of files, folders, and manuals appear in italics. For example:

$ The data is stored in the Sample.mxf file.

$ The file is located in the \Clips folder.

$ Please refer to your Matrox Mojito 4K Release Notes.

• Menus and commands that you need to choose are displayed in the form 
Menu > Command. For example, File > Save means click File in the 
menu bar, and then click Save in the menu that appears.

Last-minute information
• Any important information that wasn’t available for inclusion in this manual 

by publication time is provided to you in the Matrox Mojito 4K Release 
Notes.
About this manual



4

Cha
Your notes
pter 1, Introducing Matrox Mojito 4K



2
Installing Your Matrox Mojito 4K

Hardware and Software
This chapter explains how to 
install the Matrox Mojito 4K 
hardware and software.
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Before installing your Matrox hardware
Read the following information carefully before attempting to install the Matrox 
Mojito 4K card.

Start with a functioning system
Before attempting any Matrox Mojito 4K installation, you should have a 
computer with a supported Windows operating system fully installed and 
functioning smoothly. This will avoid potential problems later on.

Avoid costly damage
Static electricity from your body can damage your Matrox Mojito 4K card or 
your computer. Although you may not notice it, static electricity is generated 
every time you move. It’s often too small to cause a spark, but it can still cause 
damage to sensitive electronic components or at least reduce their life span.

To avoid damage, please observe the following precautions:

• Do not remove your Matrox Mojito 4K card from its antistatic bag until 
you’re ready to install it. Before removing the card, place the package within 
easy reach of the area where you intend to perform the installation.

• You should avoid touching the chips and other components on the circuit 
board. Try to handle the card by its edges.

• Try to work in an area where the relative humidity is at least 50%.

• Do not wear wool or synthetic clothing. These fabrics tend to generate more 
static electricity than cotton, which is best for this kind of work.

• Turn off the power switches on your computer and its connected 
components.

Once you’ve opened your computer, drain static electricity from your body by 
touching a bare metal surface on your computer chassis before you install or 
remove any parts of your system. If you have a grounding wrist strap, use it while 
handling and installing any components in your computer.
pter 2, Installing Your Matrox Mojito 4K Hardware and Software
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Setting the genlock termination switch
Matrox Mojito 4K features a genlock termination switch that must be set to 75 
to terminate the reference input before installing the Mojito 4K card.

Installing your Matrox Mojito 4K card
The Matrox Mojito 4K card is a three-quarter length PCIe (x8) card designed to 
operate in your computer’s x8 (electrical) PCIe slot.

For detailed instructions on how to perform the following steps, refer to your 
computer’s documentation.

1 Shut down the computer, unplug the power cord and all the cables from the 
unit, and open the computer’s chassis.

2 Insert the Matrox Mojito 4K card in an available PCIe x8 (electrical) slot in 
the computer, and secure the card into place.

²Caution To avoid overheating issues, don’t install the Matrox Mojito 4K 
card close to another card that generates heat, such as a display card.

3 Close the computer chassis, and reconnect the power cord and all the cables 
to the unit.
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Installing Matrox Mojito 4K software
Matrox Mtx.utils Setup installs the Mojito 4K device drivers, and all the software 
required to use your Mojito 4K card with supported programs. The Matrox Video 
for Windows (VFW) software codecs are included so that you can play back 
Matrox .avi files on your Mojito 4K system. Before installing Matrox Mtx.utils, 
make sure that you’ve installed the third-party software that you want to use with 
Mojito 4K, such as Adobe Premiere Pro. 

You can install Matrox Mtx.utils on a computer with or without the Matrox 
Mojito 4K card installed. To download and install the latest version of Matrox 
Mtx.utils, visit the Support section of our website at 
www.matrox.com/video/support. You can also contact your Matrox 
representative for the latest software.

Updating your Mojito 4K firmware
When you install Mtx.utils while your Mojito 4K card is installed in your 
computer, the Mtx.utils Setup program automatically verifies the firmware on 
your Mojito 4K card and updates it if required. If you install Mtx.utils on a 
computer without the Mojito 4K card, the next time you start your computer with 
your Mojito 4K card installed, Mtx.utils Setup will update your Mojito 4K 
firmware if needed.

²Caution Do not power off your computer, or interrupt the firmware update 
during the update process. Doing so may damage your Mojito 4K card.

Installing additional Matrox WYSIWYG plug-ins 
or removing unneeded plug-ins

When you install Matrox Mtx.utils, you are given the option to install the Matrox 
WYSIWYG plug-ins for any supported programs that are currently installed on 
your system. If after you’ve installed Matrox Mtx.utils you want to install 
additional Matrox WYSIWYG plug-ins, or re-install or remove a currently 
installed plug-in, you can update your system by choosing Start > All 
Programs > Matrox Mtx.utils > Update Matrox WYSIWYG Plug-ins. 
You’ll be prompted to specify which plug-ins you want to install, re-install, or 
remove. For more information about the programs supported and required 
settings, see “Using the Matrox WYSIWYG plug-ins” on page 19.”

¦ Note To install the Matrox WYSIWYG plug-in for a program, you must first 
install that program.
pter 2, Installing Your Matrox Mojito 4K Hardware and Software
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Important note about sleep and hibernation 
modes

Your system’s sleep and hibernation modes are not supported by the Matrox 
Mtx.utils software. To avoid stability issues, disable sleep and hibernation modes 
on your system after installing Matrox Mtx.utils.

Removing your Matrox Mojito 4K software
Perform the following steps to remove the Mojito 4K software from your 
computer. When uninstalling the Mojito 4K software, your current Mojito 4K 
settings are kept for future Mojito 4K software installations.

1 Choose Start > All Programs > Matrox Mtx.utils > Uninstall Matrox 
Mtx.utils.

2 Click Next.
Important note about sleep and hibernation modes
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Connecting External Devices to

Matrox Mojito 4K
This chapter explains how to 
connect external devices to 
Mojito 4K.
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Available connections
Matrox Mojito 4K offers the following connections:

• Four SDI outputs Each SDI output supports one SDI video stream. Up to 
16 channels of embedded audio are supported for SD, HD, and QFHD 
resolutions, and up to eight channels of embedded audio are supported for 
2K and 4K resolutions.

• One REF IN connector Used to connect an analog reference input source 
(tri-level sync for HD or bi-level black burst for SD).

Connecting devices to Matrox Mojito 4K
Use your SDI cables (not provided) to connect an SDI output (1, 2, 3, or 4) on the 
Matrox Mojito 4K card to an SDI video input on your monitor. You can use the 
REF IN connector to connect an analog reference input source (cable not 
provided).
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Video output mapping
To output QFHD or 4K video, all four SDI output connectors are required, and 
each output displays one quarter of the picture as follows:

• SDI 1: Top left

• SDI 2: Top right

• SDI 3: Bottom left

• SDI 4: Bottom right
Connecting devices to Matrox Mojito 4K
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Using Matrox Mojito 4K with Supported

Programs
This chapter explains how to 
define various settings for 
using your Mojito 4K with 
supported programs.
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Working with Adobe Premiere Pro
Matrox Mojito 4K supports all available sequence presets to output video and 
audio played back in Adobe Premiere Pro. Selecting a Matrox 2K, QFHD, or 4K 
preset enables full-raster H.264 intra-frame video previews in your sequence’s 
video format.

Enabling output on Matrox Mojito 4K
To use your Matrox Mojito 4K hardware to output video and audio played back 
in Adobe Premiere Pro, set your video and audio devices to use the Matrox 
Player as follows:

1 Start Adobe Premiere Pro and either open an existing project, or create a new 
project.

2 Choose Edit > Preferences > Playback.

3 From the Audio Device list, select Matrox Player.

4 Under Video Device, select Matrox Player.

5 Click Setup beside Matrox Player under Video Device, and specify your 
settings for playback as explained in “Defining your playback settings” on 
page 20.

¦ Note Closed captions in Adobe Premiere Pro are not supported on the Mojito 
4K video outputs.

Selecting a sequence preset for use with 
Matrox Mojito 4K
When you create a new sequence in your Adobe Premiere Pro project for use 
with Matrox Mojito 4K, you can select a Matrox preset that applies settings for 
rendering H.264 intra-frame previews in your sequence’s video format, and 
configures the sequence to output your mono or stereo audio to appropriate SDI 
output channels on your Matrox Mojito 4K hardware.

1 Choose File > New > Sequence. The New Sequence dialog box opens 
on the Sequence Presets page.

2 From the list of Available Presets, expand the Matrox folder and select the 
preset for the type of sequence that you want to create. For example, to 
create a sequence for editing 4096×2160p (4K) @ 29.97 fps material with 
mono audio, select the 4096x2160p 29.97 preset under Mono > 4K.

¦ Note The Matrox mono sequence presets provide eight mono audio tracks 
that are mapped to the corresponding Mojito 4K SDI output channels (A1 to 
channel 1, A2 to channel 2, and so on). The Matrox stereo sequence presets 
provide four stereo audio tracks with each stereo pair output to two SDI output 
channels (A1 to channels 1 and 2, A2 to channels 3 and 4, and so on).

3 In the Sequence Name box, specify a name for your sequence.
pter 4, Using Matrox Mojito 4K with Supported Programs
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4 Specify any other sequence settings that you want as explained in your 
Adobe Premiere Pro documentation, and click OK to apply the settings.

Working with Adobe Prelude
To use your Matrox Mojito 4K hardware to output video and audio played back 
in Adobe Prelude, set your video and audio devices to use the Matrox Player as 
follows:

1 Start Adobe Prelude and either open an existing project, or create a new 
project.

2 Choose Edit > Preferences > Playback.

3 From the Audio Device list, select Matrox Player.

4 Under Video Device, select Matrox Player.

5 Click Setup beside Matrox Player under Video Device, and specify your 
settings for playback as explained in “Defining your playback settings” on 
page 20.

Working with Adobe Encore
To use your Matrox Mojito 4K hardware to output video and audio played back 
in Adobe Encore, set your video and audio devices to use the Matrox Player as 
follows:

1 Start Adobe Encore and either open an existing project, or create a new 
project.

2 Choose Edit > Preferences > Audio/Video Out.

3 From the Audio Device list, select Matrox Player.

4 Under Video Device, select Matrox Player.

5 Click Setup beside Matrox Player under Video Device, and specify your 
settings for playback as explained in “Defining your playback settings” on 
page 20.
Working with Adobe Prelude
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Working with Adobe SpeedGrade
You can use your Matrox Mojito 4K hardware to output video played back in 
Adobe SpeedGrade as follows:

1 Start Adobe SpeedGrade and click Preferences ( ) at the top left of the 
window.

2 In the Preferences dialog box, click Playback and set the base frame rate 
for the playback, such as 29.97.

3 Click Display and select Enable under Mercury Transmit.

4 From the Device list, select Matrox Player.

5 Click Setup beside Resolution and specify the video output settings you 
want for previewing your video as explained in “Defining your playback 
settings” on page 20.

¦ Note The resolution selected in SpeedGrade is ignored when using the 
Matrox Player to output video on Mojito 4K.

6 Click OK to return to the Preferences dialog box.

For more information about using Adobe SpeedGrade, see your Adobe 
SpeedGrade documentation.
pter 4, Using Matrox Mojito 4K with Supported Programs
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Using the Matrox WYSIWYG plug-ins
The Matrox WYSIWYG plug-ins for Adobe After Effects and Photoshop let you 
preview your composition in After Effects or image in Photoshop on your video 
monitor. This lets you see the exact color temperature, safe-title area, and any 
interlaced artifacts as you work.

Configuring the Matrox WYSIWYG Control Panel
The Matrox WYSIWYG Control Panel lets you specify the settings you want for 
previewing video on your video monitor. To use the Matrox WYSIWYG Control 
Panel, right-click the  icon on your Windows taskbar. If you don’t see the  
icon, check your taskbar properties and make sure that you’re showing the icons 
for your Matrox applications. If you still don’t see the icon, choose Start > All 
Programs > Matrox Mtx.utils > Matrox WYSIWYG Control Panel.

¦ Note By default, the Matrox WYSIWYG output to your video monitor is 
enabled. To disable it, clear the Enable WYSIWYG Output option in the 
Control Panel.

1 Choose Output Configuration and specify the video output settings you 
want for previewing your video as explained in “Defining your playback 
settings” on page 20.

2 From the Preview Type menu, select one of the following options for the 
preview:

$ Video Select this to view your composition/image.

$ Alpha Channel Select this to view only the grayscale alpha-key (matte) 
information from your composition/image.

3 From the Scaling menu, select one of the following options for your preview 
output:

$ Scale to fit Select this to scale your composition/image to your 
selected video output format (the aspect ratio will be preserved).

$ Original Size Select this to output your composition/image without any 
scaling. The output will be centered on your video monitor, and cropped if 
needed.

Required steps to use the WYSIWYG plug-ins
The following sections list the steps required to use the Matrox WYSIWYG 
plug-ins for Adobe After Effects and Photoshop in order to preview video on 
your video monitor.

Adobe After Effects
1 Start Adobe After Effects and import the footage you want to preview.

2 Drag the footage from the Project panel to the Composition panel.
Using the Matrox WYSIWYG plug-ins
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Adobe Photoshop
1 Start Adobe Photoshop and open the file you want to preview.

2 Choose File > Export > Matrox WYSIWYG Preview.

Defining your playback settings
The Matrox Playback Settings dialog box provides various settings that you 
can use to configure your Matrox Mojito 4K video output and genlock settings.

1 If you’re using Adobe Premiere Pro, you can select Lock video output 
format to ensure that the currently selected video output format won’t 
change when working in your project. When this option is cleared, your 
sequence’s video output may change to a different format when you open a 
title or graphic in the Source Monitor or use the Multi-Camera Monitor.

¡ Important When Lock video output format is selected, you won’t be 
able to change the video output format, and the currently selected format will 
be applied to all sequences in your project. Therefore, make sure that you’ve 
selected the video output format that you want (see step 3 below) before 
selecting this option. In order to specify a different video output format for 
each sequence in your project, the video output format must not be locked.
pter 4, Using Matrox Mojito 4K with Supported Programs
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2 Select Enable 3G Level B if you want to output 3G Level B video when 
outputting1080p, 2K, QFHD, or 4K video at 50 fps or 59.94 fps. Otherwise, 
3G Level A video will be output for these formats.

3 Under Video Output Format, select the format that you want for your 
video output. For a list of the supported formats, see “Supported video 
output formats” on page 22.

4 Under Video Bit Depth, select either 8-bit or 10-bit to indicate the bit 
depth you want for your video output.

5 Under Luminance Levels, you can select any of the following options if 
required:

$ Allow super white Allows the highest luminance level of your video 
output to exceed the standard maximum white level.

$ Allow super black Allows the lowest luminance level of your video 
output to fall below the standard black level.

¦ Note Super white and super black should not be allowed when producing 
your final video production for broadcast.

6 Under Genlock Source, select one of the following:

$ Internal Genlock to the Mojito 4K internal reference signal. Select this 
option only if you don’t have an external video sync source.

$ Black Burst Broadcast Quality Genlock to an external analog sync 
source connected to the reference input (REF IN) on Mojito 4K. This 
must be a stable sync source, such as an external sync generator (bi-level 
black burst for SD or tri-level sync for HD).

¦ Note The status of your genlock source will be displayed, such as Locked 
or Not Locked, to indicate whether or not Mojito 4K is presently locked to 
your selected genlock source. When you change the genlock source, distorted 
video and silent audio will be output until Mojito 4K locks to the new genlock 
source.

7 Under Genlock Video Format, select your genlock source’s video format. 
If you can’t select a video format, make sure that your genlock source 
matches the specified video format. When the genlock source is set to 
Internal, the genlock video format is set to the currently selected video 
output format.

8 Under Advanced Genlock Settings, drag the Horizontal Delay and 
Vertical Delay sliders to adjust the horizontal and vertical timing of your 
video outputs with respect to your genlock source. This lets you compensate 
for cable delays within your system.

9 Click OK to save your settings.
Defining your playback settings
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Supported video output formats
The following table shows the video output formats that are supported on the 
Matrox Mojito 4K video outputs (same format on all outputs).

Video output format Frame rate (fps) Transport type

SD resolutions1

NTSC 29.97 1×SD-SDI

PAL 25 1×SD-SDI

HD resolutions1

720p 50 or 59.94 1×HD-SDI

1080i 25 or 29.97 1×HD-SDI

1080PsF 23.98, 25, or 29.97 1×HD-SDI

1080p 23.98, 25, or 29.97 1×HD-SDI

1080p 3G Level A 50 or 59.94 1×3G-SDI Level A

1080p 3G Level B 50 or 59.94 1×3G-SDI Level B

2K resolutions1

2048×1080PsF 23.98, 25, or 29.97 1×HD-SDI

2048×1080p 23.98, 25, or 29.97 1×HD-SDI

2048×1080p 3G Level A 50 or 59.94 1×3G-SDI Level A

2048×1080p 3G Level B 50 or 59.94 1×3G-SDI Level B

QFHD resolutions2

3840×2160PsF 23.98, 25, or 29.97 4×HD-SDI

3840×2160p 23.98, 25, or 29.97 4×HD-SDI

3840×2160p 3G Level A 50 or 59.94 4×3G-SDI Level A

3840×2160p 3G Level B 50 or 59.94 4×3G-SDI Level B

4K resolutions2

4096×2160PsF 23.98, 25, or 29.97 4×HD-SDI

4096×2160p 23.98, 25, or 29.97 4×HD-SDI

4096×2160p 3G Level A 50 or 59.94 4×3G-SDI Level A

4096×2160p 3G Level B 50 or 59.94 4×3G-SDI Level B
1 When outputting to an SD, HD, or 2K resolution, the video and audio are duplicated on all 

outputs.
2 When outputting to a QFHD or 4K resolution, the audio is output only on the first SDI output.
pter 4, Using Matrox Mojito 4K with Supported Programs
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Monitoring Your Matrox Mojito 4K

System
This chapter explains how to 
use the Matrox X.info program 
to display important details 
about your Matrox Mojito 4K 
system and installed Mojito 4K 
card.
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Using X.info to display Mojito 4K information
The Matrox X.info program lets you display information about your Matrox 
Mojito 4K system and installed Mojito 4K card, and provides warnings when 
certain problems arise, such as when the temperature of your Mojito 4K card 
exceeds the maximum operating temperature.

Matrox X.info runs continuously to monitor your system, whenever your 
computer is turned on and the Mojito 4K card is installed. You can open Matrox 
X.info to display system and hardware details by double-clicking the  icon on 
your Windows taskbar.

¦ Note If you do not see the icon, check your taskbar properties and make sure 
that you’re showing the icon for Matrox X.info.

Displaying system information
To display information about your Matrox Mojito 4K system, select System 
from the Display Information About list. On this page, you can see Install 
Information, such as the install path and version of Matrox Mtx.utils. 

You can also create an HTML log file of your system information, which can be 
useful for troubleshooting. To create this log, use the Browse button under 
System Information Log to select the path and name of the log, then click 
Create. If Open file after scan is selected, the HTML system log opens after it 
is created.
pter 5, Monitoring Your Matrox Mojito 4K System



25
If you had previously turned off certain Matrox warnings and want them to be 
re-enabled, click Re-enable Warnings. For example, some Matrox warnings 
provide an option to turn off the warning (that is, you can select Don’t display 
this message again). Clicking Re-enable Warnings allows these warnings to 
be displayed again.
Using X.info to display Mojito 4K information
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Displaying hardware information
To display information about your Matrox Mojito 4K card, select Hardware 
from the Display Information About list. This displays a page with hardware 
information (for example, serial number and production date). You can also 
monitor the current and maximum operating temperatures for your card 

¡ Important Whether or not you have opened Matrox X.info, if your Mojito 4K 
card exceeds the maximum operating temperature, you’ll receive a warning 
message with further instructions as explained in “Error notification” on page 27.
pter 5, Monitoring Your Matrox Mojito 4K System
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Monitoring your Mojito 4K card’s operating 
temperatures
As shown in the X.info Hardware section, the Mojito 4K Card page displays 
the current and maximum operating temperatures of your Mojito 4K card’s 
hardware components. To avoid damage to your Mojito 4K card, make sure that 
you don’t operate your card at or near the maximum temperature for a prolonged 
period of time. You should target your Mojito 4K card to operate at least 10°C 
below the maximum operating temperature.

You should monitor the temperature of your Mojito 4K card periodically and take 
measures as needed to lower the room temperature and/or improve the ventilation 
in your Mojito 4K system. If needed, move your Mojito 4K card to a PCIe slot in 
your computer that is not too close to another card that generates heat, such as a 
display card.

Error notification
X.info provides temperature warnings and warnings for other possible Mojito 4K 
card problems. Once X.info has detected a hardware problem, the Matrox X.info 
Notification dialog box will be displayed to give you details of the problem and 
further instructions. You will not be able to close this dialog box until the 
problem has been resolved.
Using X.info to display Mojito 4K information
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Matrox Mojito 4K Specifications

This appendix provides the 
Matrox Mojito 4K card 
specifications.
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General
• Video formats NTSC, PAL, 720p, 1080i/p/PsF, 2K (2048×1080)p/PsF, 

QFHD (3840×2160)p/PsF, 4K (4096×2160)p/PsF

• Regulatory compliance

$ FCC Class A, CE Mark Class A, and ACMA Class A

$ RoHS Directive 2002/95/EC

• Matrox Mojito 4K card

$ Three-quarter length PCIe (x8) card

$ PCB dimensions:

• L 23.2 cm (9.125 in) × W 10.7 cm (4.2 in)

• Overall thickness including components: 1.9 cm (0.75 in)

• Typical operating voltages and current consumption

Connections
• SDI video outputs

$ Four simultaneous SDI outputs: SD, HD (includes 2K), and 3G Level A 
or B

$ Compliant with SMPTE 259M, SMPTE 292M, SMPTE 424M, and 
SMPTE 425M-AB

$ One QFHD (3840×2160 up to 59.94 fps) or 4K (4096×2160 up to 
59.94 fps) on four SDI outputs, 4:2:2 10-bit (3G Level A or B)

$ BNC connector (75 ), terminated

$ Equalized output for maximum cable length

• Embedded audio outputs

$ Up to 16 channels of embedded audio are supported for SD, HD, and 
QFHD resolutions

$ Up to eight channels of embedded audio are supported for 2K and 4K 
resolutions

$ In accordance with SMPTE 272M A, B, and C (SD), and 
SMPTE 299M (HD)

$ 48 kHz sampling rate

$ 24-bit audio streams are supported

Voltage +3.3 V +12 V

Current 3.0 A 1.3 A

Total power consumption: 23 watts
endix A, Matrox Mojito 4K Specifications
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• Genlock reference input

$ HD analog tri-level sync or SD analog bi-level black burst

$ BNC connector (75 ), terminated

Environmental specifications
• Minimum/maximum room operating temperature1: 0º to 55º C (32º to 

131º F)

• Minimum/maximum storage temperature: –40º to 75º C (-40º to 167º F)

• Maximum altitude for operation: 3,000 meters

• Maximum altitude for transport: 12,000 meters

• Operating humidity: 20% to 80% relative humidity (non-condensing)

• Storage humidity: 5% to 95% relative humidity (non-condensing)

1 This temperature range assumes that the hardware components on the card don’t exceed 
the maximum operating temperature as explained in “Monitoring your Mojito 4K card’s 
operating temperatures” on page 27.
Environmental specifications
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Matrox Customer Support

This appendix explains how 
you can register your Matrox 
product and obtain customer 
support.
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Appendix B, Matrox Customer Support

How to get Matrox customer support
If you have a problem that you’re unable to solve by referring to the 
documentation for your Matrox product, please contact your Matrox 
representative. He or she should be able to help you quickly correct any 
installation or system configuration problem.

If your representative is unable to solve your problem, contact Matrox for further 
information and assistance.

Registration
You can register your Matrox product in the Matrox Support section of our 
website at www.matrox.com/video/support.  

Only registered users are entitled to customer support, software updates, special 
promotional offers, and access to our user forum.

Keep up to date with our website
In addition to registering your Matrox product, our website offers you 
up-to-the-minute information about Matrox products and software updates. Be 
sure to place our site in your favorites or bookmarks: 
www.matrox.com/video/support.

Contacting us
Matrox is proud to offer worldwide customer support. Please use the contact 
information for your Matrox product and area as provided on our website at 
www.matrox.com/video/support.

http://www.matrox.com/video/support
http://www.matrox.com/video/support
www.matrox.com/video/support
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Compliance Statements
USA
FCC Compliance Statement
Remark for the Matrox hardware products supported by this guide
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the instructions manual, may cause harmful interference to radio communications. Operation of 
this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

WARNING
Changes or modifications to this unit not expressly approved by the party responsible for the compliance could void the user’s authority to operate this equipment. The 
use of shielded cables for connection of the equipment and other peripherals is required to meet FCC requirements.

Canada
(English) Industry Canada Compliance Statement
CAN ICES-3 (A)/NMB-3 (A)
Remark for the Matrox hardware products supported by this guide
These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

(Français) Conformité avec les exigences de l’Industrie Canada
CAN ICES-3 (A)/NMB-3 (A)
Remarque sur les produits matériels Matrox couverts par ce guide
Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur 
le brouillage radioélectrique édicté par Industrie Canada.

Europe
(English) European user’s information – Declaration of Conformity
Remark for the Matrox hardware products supported by this guide
These devices comply with EC Directive 2006/95/EC for a Class A digital device. They have been tested and found to comply with EN55022/CISPR22 and 
EN55024/CISPR24. In a domestic environment these products may cause radio interference in which case the user may be required to take adequate measures. To meet 
EC requirements, shielded cables must be used to connect the equipment and other peripherals. These products have been tested in a typical Class A compliant host 
system. It is assumed that these products will also achieve compliance in any Class A compliant system.

(Français) Informations aux utilisateurs Européens – Déclaration de conformité
Remarque sur les produits matériels Matrox couverts par ce guide
Ces unités sont conformes à la directive communautaire 2006/95/EC pour les unités numériques de classe A. Les tests effectués ont prouvé qu’elles sont conformes aux 
normes EN55022/CISPR22 et EN55024/CISPR24. Le fonctionnement de ces produits dans un environnement résidentiel peut causer des interférences radio, dans ce cas 
l’utilisateur peut être amené à prendre les mesures appropriées. Pour respecter les impératifs communautaires, les câbles de connexion entre l’équipement et ses 
périphériques doivent être blindés. Ces produits ont été testés dans un système hôte typique compatible classe A. On suppose qu’ils présenteront la même compatibilité 
dans tout système compatible classe A.

(Deutsch) Information für europäische Anwender – Konformitätserklärung
Anmerkung für die Matrox Hardware-Produktunterstützung durch dieses Handbuch
Diese Geräte entsprechen EG Direktive 2006/95/EC für ein digitales Gerät Klasse A. Sie wurden getestet und entsprechen demnach EN55022/CISPR22 und 
EN55024/CISPR24. In einer Wohnumgebung können diese Produkte Funkinterferenzen erzeugen, und der Benutzer kann genötigt sein, entsprechende Maßnahmen zu 
ergreifen. Um EG-Anforderungen zu entsprechen, müssen zum Anschließen des ausrüstung und anderer Peripheriegeräte abgeschirmte Kabel verwendet werden. Diese 
Produkt wurden in einem typischen, der Klasse A entsprechenden, Host-System getestet. Es wird davon ausgegangen, daß diese Produkte auch in jedem Klasse A 
entsprechenden System entsprechend funktionieren.

(Italiano) Informazioni per gli utenti europei – Dichiarazione di conformità
Nota per i prodotti hardware Matrox supportati da questa guida
Questi dispositivi sono conformi alla direttiva CEE 2006/95/EC relativamente ai dispositivi digitali di Classe A. Sono stati provati e sono risultati conformi alle norme 
EN55022/CISPR22 e EN55024/CISPR24. In un ambiente domestico, questi prodotti possono causare radiointerferenze, nel qual caso all’utente potrebbe venire richiesto 
di prendere le misure adeguate. Per soddisfare i requisiti CEE, l’apparecchiatura e le altre periferiche vanno collegati con cavi schermati. Questi prodotti sono stati provati 
in un tipico sistema host conforme alla Classe A. Inoltre, si dà per scontato che questi prodotti acquisiranno la conformità in qualsiasi sistema conforme alla Classe A.

(Español) Información para usuarios europeos – Declaración de conformidad
Observación referente a los productos de hardware de Matrox apoyados por este manual
Estos dispositivos cumplen con la directiva de la CE 2006/95/EC para dispositivos digitales de Clase A. Dichos dispositivos han sido sometidos a prueba y se ha 
comprobado que cumplen con las normas EN55022/CISPR22 y EN55024/CISPR24. En entornos residenciales, estos productos pueden causar interferencias en las 
comunicaciones por radio; en tal caso el usuario deberá adoptar las medidas adecuadas. Para satisfacer las disposiciones de la CE, deberán utilizarse cables apantallados 
para conectar el equipo y demás periféricos. Estos productos han sido sometidos a prueba en un típico sistema anfitrión que responde a los requisitos de la Clase A. Se 
supone que estos productos cumplirán también con las normas en cualquier sistema que responda a los requisitos de la Clase A.



www.matrox.com/video


	Trademarks
	Matrox Limited Warranty
	Matrox Software License Agreement
	Matrox End-User VFW Software Codec License Agreement (“Agreement”)
	Introducing Matrox Mojito 4K
	Welcome to Matrox Mojito 4K
	System requirements
	Supported programs
	Check our website for equipment information

	About this manual
	Style conventions
	Last-minute information


	Installing Your Matrox Mojito 4K Hardware and Software
	Before installing your Matrox hardware
	Start with a functioning system
	Avoid costly damage
	Setting the genlock termination switch

	Installing your Matrox Mojito 4K card
	Installing Matrox Mojito 4K software
	Updating your Mojito 4K firmware

	Installing additional Matrox WYSIWYG plug-ins or removing unneeded plug-ins
	Important note about sleep and hibernation modes
	Removing your Matrox Mojito 4K software

	Connecting External Devices to Matrox Mojito 4K
	Available connections
	Connecting devices to Matrox Mojito 4K
	Video output mapping


	Using Matrox Mojito 4K with Supported Programs
	Working with Adobe Premiere Pro
	Enabling output on Matrox Mojito 4K
	Selecting a sequence preset for use with Matrox Mojito 4K

	Working with Adobe Prelude
	Working with Adobe Encore
	Working with Adobe SpeedGrade
	Using the Matrox WYSIWYG plug-ins
	Configuring the Matrox WYSIWYG Control Panel
	Required steps to use the WYSIWYG plug-ins

	Defining your playback settings
	Supported video output formats

	Monitoring Your Matrox Mojito 4K System
	Using X.info to display Mojito 4K information
	Displaying system information
	Displaying hardware information
	Monitoring your Mojito 4K card’s operating temperatures
	Error notification


	Matrox Mojito 4K Specifications
	General
	Connections
	Environmental specifications

	Matrox Customer Support
	How to get Matrox customer support
	Registration
	Keep up to date with our website
	Contacting us


	Index
	Compliance Statements

